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From The Chief Editor's Desk
I think if I hear "in these uncertain times" or "in these difficult times" one more time, I'm going to S-C-R-E-A-M! Of course these are uncertain/difficult times. The world hasn't had to deal with a pandemic on this scale in over 100 years. Anything that disrupts our daily routine, and thus life, makes things uncertain and/or difficult.
Humans, by their nature, are nothing at all if they are not creatures of habit. We tend to dislike anything that goes against the established "norm" and anything that changes our deeply rooted routines. Difficulty induces change. Change creates uncertainty. Uncertainty breeds chaos. Chaos gives birth to adaptation. It's the same merry-go-round we've been riding since before we evolved to walk upright. Lather. Rinse. Repeat.
Besides being creatures of habit, humans are also very adaptable. Just take a look around at how many climates we thrive in. Humans live and thrive in climates from the frozen extremes to the equatorial tropics ... and everything in between offered by our planet. The same can be said for economic systems, governmental systems, social systems, and just about every other type of "system" you can think of.
All of this contributes to one main point: humans are survivors. The gifts of logic, thought, ingenuity, adaptability, and many more attributes make humans able to survive a lot of variables that are thrown our way. We have survived floods, earthquakes, tornadoes, fire, pestilence, oppression, aggression, and disease. On this latter variable, we have survived polio, smallpox, bubonic plague, measles, mumps, colds, influenza, and a whole host of other diseases that have attempted to thin our numbers out. Such will be the case with this latest assault on humanity by the coronavirus SARS-CoV-2.

Which brings me completely full circle, back to the beginning of this article. Saying "in these uncertain times" or "in these difficult times" does nothing to ease the stresses that most of the population has experienced as a result of the lockdown that most of the global citizenry has experienced through its response to the pandemic. Instead, it sounds and feels very disingenuous, dishonest and insincere. It's whole goal is to make the person saying those trite phrases feel better. And frankly, I neither need nor want the false sympathies.
What's more important going forward through this pandemic isn't the false sympathies and fake platitudes. It is how you handle yourself, and that you make good, sound decisions. Be cautious, because the longer the pandemic goes on, the greater the chance that you'll let your guard down. It's also likely that you might not make your usual sound decisions, because your normal feedback system (lack of contact with your usual group of friends and acquaintances) has been disrupted. Just as you might imagine, this has been studied.
Physician/researcher Donald A. Redelmeier and behavioral scientist Eldar Shafir just published a study (PDF) in the Lancet medical journal addressing exactly these possible pitfalls. Since most countries around the world are looking at relaxing the lockdown orders, most people might assume that the worst of the pandemic is over. But that couldn't possibly be farther from the truth.

It's still important to safeguard yourself and your loved ones. Keep maintaining social distancing. Wear masks when out in public. Wash your hands frequently for at least 20 seconds. Use alcohol-based hand sanitizer when you cannot access soap and water for proper handwashing. Cover your cough and sneeze properly. If you're not feeling well, stay away from others. Avoid crowds and situations where proper social distancing cannot be maintained.
This pandemic is far from over. Don't. Let. Your. Guard. Down.
On a side note, this month's cover celebrates Space Day, which happens the first Friday of May. This year, that occurs on May 1. The cover was designed by Meemaw.
Until next month, I bid you peace, happiness, serenity, prosperity ... and continued good health! Stay vigilant!


Staying "Safe" While You Stream: DBD's Tips On Living DRM-Free During Quarantine
by Greg Farough
Defective by Design, April 7, 2020
Reprinted under Creative Commons
Attribution-No Derivative Works 4.0 license
As most of us are cooped up in our homes due to the ongoing COVID-19 pandemic, it's somewhat natural that we turn to online movies, music, and other media to help pass the time. For most people, this involves turning to Internet streaming for convenient, "all-in-one" services that promise an endless array of recommendations to while away the hours. "Binging" is all well and good every once in a while, but we should remain careful that the ways we're getting our media don't come with compromises to our freedom. As we've mentioned before, Netflix and other giant media providers are responsible for keeping the practice of DRM (Digital Restrictions Management) alive, and it's important not to provide them with the subscription fees they need to keep going. It's also important, even under less dire circumstances, to support businesses and websites that provide DRM-free media, and to promote them to our friends. So to help provide you with a plethora of DRM-free and often gratis places to stream from while keeping your rights, here's a few choice selections from our Guide to DRM-free Living.

When it comes to finding good videos to watch during times of crisis, we'd be remiss if we didn't mention the Internet Archive. This section of the digital library contains bona-fide cinematic masterpieces like Nosferatu, as well as "classics" of a different sort like Plan 9 from Outer Space. Many of these works have been voluntarily uploaded to the Archive by their creators, or, like Night of the Living Dead, have fallen into the public domain due to some of the vagaries and finer points in United States copyright law.

Bandcamp remains a favorite when it comes to how to get your music. Not only is every artist, album, and track listed on it free from DRM, but it's a good way to support your favorite independent artists, as well as discover new ones. And while everyone's shipping might be a little delayed, many artists sell physical copies of their work on the site as well, meaning that those of us who prefer physical media don't have to be left in the lurch. Plus, it's worth mentioning that Bandcamp is one of the main places musicians working in the free culture movement go to share their works first.
Of course, you can also avoid streaming services that are compromised by DRM by simply going "local," using standalone video and audio players like the ever popular VLC media player or mpv to play your local collection of media. For diving into free culture music, there are few better places than Libre.fm. And if you're really ambitious, look into hosting your very own music stream for you and your friends using self-hosted tools like Airsonic or Funkwhale. Take that, Spotify!
Time under quarantine is also the perfect opportunity to learn about new topics -- even the fight against DRM itself! The [LibrePlanet video library][17] is an excellent place to find talks covering issues relating to the Defective by Design campaign, such as Cory Doctorow's keynote presentation on the "software you can go to jail for talking about", this 2019 session from the Library Freedom Institute, and a talk given on the Right to Repair movement.
No matter what types of media you enjoy or what your favorite genres are, your friends at Defective by Design sincerely wish you the best in this difficult period. And if you've found the information we've listed above helpful, visit this link to learn how you can support the campaign. In addition to our Twitter account, a platform we recommend only with caveats, the Defective by Design campaign is now on Mastodon at @endDRM. To show your support of the campaign publicly, you can use the #drmfree or #defectivebydesign hashtags from your own favorite microblogging service.
Happy and healthy hacking!

PCLinuxOS Recipe Corner: Lemon Pepper Chicken
Lemon Pepper Chicken
Low Carbohydrate 3g
INGREDIENTS:
3 tablespoons butter
8 bone-in skin-on chicken thighs (2 1/2 to 3 lb total)
1 teaspoon lemon pepper
1/2 teaspoon salt
2 teaspoons finely chopped garlic
1 cup chicken broth (from 32-oz carton)
2 teaspoons grated lemon peel and 2 tablespoons lemon juice (from 1 large lemon)
2 tablespoons cold water
2 tablespoons cornstarch
DIRECTIONS:
Spray 3 1/2- to 4-quart slow cooker with cooking spray.
In a 12-inch nonstick skillet, heat 1 tablespoon of the butter over medium-high heat. Season chicken with 1/2 teaspoon of the lemon pepper and the salt. Place half of the chicken thighs skin-side down in a skillet; cook 4 to 5 minutes or until skin is golden brown and chicken releases easily from the surface. Turn chicken over; cook for 2 minutes. Repeat for remaining chicken.
Layer chicken thighs, skin-side up, inside slow cooker; sprinkle with garlic. In a 2-cup measuring cup, mix chicken broth, lemon peel, lemon juice and remaining 1/2 teaspoon lemon pepper; pour over chicken thighs. Cover and cook on Low heat setting 3 to 3 1/2 hours or until chicken is tender (at least 165 degrees F).
Remove chicken to a serving platter; cover and keep warm. In a small bowl, mix water and cornstarch; beat with whisk into cooking juices in a slow cooker. Cover and cook on High heat setting 20 to 30 minutes or until slightly thickened and bubbly around edges. Stir in remaining 2 tablespoons butter.
TIPS:
If desired, garnish with fresh slices of lemon or chopped Italian (flat-leaf) parsley.
Add a green vegetable and rice or noodles for a complete meal.
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Wallpaper Roundup, Revisited
by Paul Arnote (parnote)
Looking through the Monthly Screenshots section of the PCLinuxOS forum, it's apparent that there are many individuals who know how to find great looking wallpapers for their desktops. But for others, finding high quality images for their desktops isn't so easy. Plus, with so many of us spending so much time at home, quarantined to help prevent the spread of coronavirus (or to help flatten the curve), it's inevitable that many will be spending an increasing amount of time on their computers. You might as well have some nice wallpaper to look at while spending all of that extra time in front of your computer.
Let me help you with that. There are several places on the web where you can find high quality images for your desktops ... that are free! So, let's take a look at some of them.
Before we start, though, let me give you one word of advice: be cautious! Collecting cool and unusual wallpapers can be a very addicting pursuit. It won't take long for you to wonder where all your hard drive space went!
Bing
Think what you will about Microsoft's search engine. But it does have one really awesome feature that sets it apart from the crowd. Each and every day, it features a new, high quality image that it uses as its background image.
There are whole websites dedicated to collecting and sharing the various Bing images. With just these images alone, you will be able to create some stunning desktops.

One site, Bing Wallpaper Gallery, is a great place to start. There are (on my laptop, anyway) 30 images per page ... and there are 28 pages filled with those high quality images.

Bing Wallpaper Download is another site that collects and "redistributes" the daily Bing images. There are 446 pages of images, with 10 images on each page.

One of the coolest, and probably most complete collections of Bing images, is from Bing Wallpaper Archive. Each month's images are displayed as a slideshow. When the image you want flashes before you on your screen, click on the image. The selected image will open in a new tab in your browser, where you can right-click your mouse on the image to save the image file to your hard drive. The monthly collections go all the way back to May, 2009, making this collection of Bing images massive.
I have also created a bash script to download the daily images from Bing. I originally wrote about it in the October, 2013 issue of The PCLinuxOS magazine. Since then, I've done some minor upgrades to the script, due to the slight changes in the way that the images were presented by Bing. You can download my updated script here.
Download the file to some location in your path, change the filename from bing5.sh.txt to bing5.sh, make the filename executable, and then run from a command line prompt (or run it when your computer first starts by placing it in your desktop's "startup" utility that starts programs when your desktop first starts). I've annotated the script (open ONLY in a bona fide TXT editor, like Kate, Mousepad, Leafpad, Geany, etc.!) so you can make any changes that you might want (like how long it waits to download the image after the script is run). You can also set up the script to run "automagically" every day at the same time by assigning it to a crontab job.

WallpaperStock.com has a literal ton of free, high quality wallpaper images. They are grouped together in categories, such as the Linux category shown above. You can also select the desired screen resolution (left side of the page).

Desktop Nexus is an often overlooked site ... except for its 1 million registered users, who have uploaded over 1.5 million high quality wallpaper image files! And no, you do not have to register to use the site.
All of the images are sorted into categories, which they call "Galleries." Clicking any one of the galleries/categories opens up a whole slew of new subcategories. The images are sorted by "votes," which makes it easier to find popular image files. You do have to be a member to vote on images, though.

Wallhaven has a collection of over 700,000 high quality wallpaper images for you to browse and download. The site originally was designed to replace the now-defunct Wallbase. Once you sign up for a free account, you can browse for images by tags or popularity, search for "safe for work" images (or not), choose your favorite image resolution, or just take your chances with a random selection. The site features infinite scroll, so you don't have to load multiple pages of images to find the images you are interested in.

Social Wallpapering has been around for quite a while (since at least 2007). They have a quite large collection of high quality wallpaper images. Clicking on the "Browse" button will display some image categories to help you narrow your search to something you are interested in. You can also upload your own high quality images to the site, as well. Users can "up vote" or "down vote" images based on whether or not they like the images. Voting privileges are granted after signing up for a free account.

If you're looking for something eclectic or unique, you could do no better than DeviantArt. The site is THE site for artists, and they have a very large following. The collection of wallpaper images includes photos, illustrations, abstract art, fantasy art, fan art, video game art, movie art, comics art, and much more. Here's a hint: even if it says to "purchase" the image, click on it. Most of the time you'll be shown a high resolution image of your selection, and saving it to your hard drive is as easy as right clicking on the image and selecting "Save Image As..." from the context menu in your browser.

Updated daily, HDWallpapers.net is full of HD photos and illustrations just waiting to adorn your desktop. You can sort by featured images, popular images, the latest images, or browse based on category. Downloads can be chosen based on screen resolution, a specific mobile device, or a particular use (e.g., for use as a cover photo on social media platforms). No account is necessary to download images, but a free account is required to upload images and to save a list of your favorites.

Interfacelift has been around for quite a long time now. Originally created in October, 1999, the site is a premier resource for gorgeous wallpapers. They have lots of natural scenes, photos, and more. You can also find icon packs and system themes on Interfacelift.
The site will automatically detect your screen resolution, and use that information to show you wallpapers that fit your screen. However, you can also sort wallpapers by screen resolution or device. One really nice and unique feature of Interfacelift is that you can see lots of additional information about the images, such as the camera used to shoot the image, who took them, and any comments that were added to the images.

Just as its name states, the wallpapers on Simple Desktops are simple. According to the "About" information on the site, Simple Desktops includes "a collection of wallpapers designed to make your computer beautiful without distraction." Calling the wallpapers on Simple Desktops "minimalist" would be an understatement. They definitely are not distracting, at least in the normal sense of what we define as distracting.
Summary
There you have it. I've given you several sites to go look for wallpaper to adorn your desktop. There are many other sites out there. I eliminated some from my list, like Digital Blasphemy, because they charge either a membership fee, or they charge per image. There are plenty of other places on the internet to grab some free wallpapers, so there's little to no need to pay for them. A quick search for "free wallpaper images" will net you a literal ton of sites where you can download them freely.
So now, go out and dress up your desktops!





ms_meme's Nook: I Want It That Way
Short Topix: Zoombombing Is A Crime, Not A Prank
by Paul Arnote (parnote)
Study Reveals Hidden Behaviors Of Mobile Apps

Fresh from a report (PDF) jointly published by authors from The Ohio State University, New York University, and CISPA Helmholtz Center for Information Security comes word that 12,706 apps surveyed with a new static analysis technique called InputScope had hidden backdoors, hidden master passwords, secret access keys, hidden blacklist words, and secret commands embedded within them. These vulnerabilities allow users to access admin-only functions, or attackers to gain access to user information and user accounts.
An article on ZDNet dug further into the report. The authors had surveyed 100,000 of the most popular apps in the Google Play store (based on the number of installations), the top 20,000 apps hosted on third party app stores, and 30,000 apps that came preinstalled on Samsung handsets.
Overall, they found that nearly 6,900 apps from the Google Play store had hidden backdoors or functions. Nearly 1,100 apps from the third party app stores had hidden backdoors. Meanwhile, nearly 4,800 preinstalled apps from Samsung handsets (almost 16%) featured hidden backdoors.
More than 4,000 apps (total) featured hidden "bad word" filters to filter out curse words, racial slurs, political words (even the names of some political leaders), gambling, cult references, pornography, and drugs.
The authors of the report did not divulge the names of the apps where they found these security issues, in order to protect the users of those apps from malicious actors. The app developers were all notified of the findings, but not all of the app developers responded.
Out To Sea, Sailing About The World, They Never Heard About The Pandemic

Imagine quitting your job, buying a boat, and setting out to sail around the world. Sounds like a dream, huh? That's exactly what Elena Manighetti and Ryan Osborne of Manchester, England did in 2017, according to a BBC story. They sailed about the Atlantic Ocean, sailing from one location to the next.
Except the dream turned sour, as dreams sometimes do.
They had asked their families to stay in touch. But, they had one ground rule: no bad news. And, the family members complied with that wish.
They first attempted to land on a small island that was a French territory. But, they found all the borders closed, and the island in the process of being locked down. So, they sailed on to Grenada.
Back in February, they heard a little bit of something about a virus in China. But, because there wasn't much information available about it, they thought it would be all over after spending 25 days at sea.
Yes. Their families kept their word. They didn't tell them about the coronavirus pandemic. That was bad news. About as bad of news as you might expect. They didn't know that the entire world was infected.
Just off the coast of Grenada, they were able to get a good-enough 4G connection to allow them to find out what had been going on. They contacted a friend already on Saint Vincent, and were told that Elena would be refused entry, because she was an Italian citizen. Her home in Italy is in one of the hardest hit areas of the country. Except Elena hadn't been to her home country in months.
Fortunately, they were able to prove via their travel documents and their boat's GPS data that they had not been to Italy in months, and had actually spent the last 25 days sailing the ocean.
Elena's family is well, she found out while contacting family in Italy, but they know people who have succumbed to COVID-19. They described how horrible conditions are in the ancient country on the Mediterranean Sea.
For now, they are sitting tight on Saint Vincent, hopeful that they will soon be able to continue their exploration of the Caribbean isles. But they are worried, because they also want to avoid the hurricane season, which typically begins in June.
New Linux Patch Speeds Up FAT Transfer Times By 7.5X

Just days before Linus Torvalds closed the merge window and released the first release candidate for the Linux kernel 5.7, kernel developer Ogawa Hirofumi sent out a patch that speeds up FAT file transfers on Linux by 7.5 times.
Hirofumi's patch enhances the read-ahead performance of Linux's FAT file system code, according to an article on FOSSBytes. To validate the patch, Hirofumi tested the driver on a slow, USB connected 2TB hard drive. File transfer times went from 383.18 seconds to 51.03 seconds after application of the patch.
Even though most have moved to exFAT, the older FAT16/FAT32 file system is still in use in some digital cameras and EFI partitions.
Prosecutors: Zoombombing Still A Crime

With the near-global coronavirus lockdown and social distancing having taken a prominent role in our daily lives, Zoom, a video conferencing program, has gained a ton of recent popularity.
But, as with most anything that becomes popular, trolls and other users with malintent have to come along and ruin things. Sadly, they have taken to exposing themselves to children and yelling racial slurs -- among other things -- as they join Zoom meetings just to disrupt them. The idjits claim that it's just a prank. But not so fast, say U.S. federal prosecutors, according to an article on ArsTechnica. They say it's a crime.
From a statement released by the U.S. Department of Justice, U.S. Attorney's Office of the Eastern District of Michigan:
Michigan's chief federal, state, and local law enforcement officials are joining together to warn anyone who hacks into a teleconference can be charged with state or federal crimes. Charges may include -- to name just a few -- disrupting a public meeting, computer intrusion, using a computer to commit a crime, hate crimes, fraud, or transmitting threatening communications. All of these charges are punishable by fines and imprisonment.
"You think Zoom bombing is funny? Let's see how funny it is after you get arrested," stated Matthew Schneider, United States Attorney for Eastern Michigan. "If you interfere with a teleconference or public meeting in Michigan, you could have federal, state, or local law enforcement knocking at your door."
"It is a shame that during a pandemic which is causing fear and anxiety across the globe that there are wrongdoers seeking to disrupt virtual environments which have become essential to communication, teleworking and online learning," said Special Agent in Charge Steven M. D'Antuono. "While Michiganders are sheltering in place, it is important to practice good cyber hygiene. We encourage our communities to visit fbi.gov or ic3.gov to learn more about tips they can take to keep their devices secure."
"We were alerted to this problem by a Michigan reporter who participated in a Zoom conference that was hijacked," stated Michigan Attorney General Dana Nessel. "Since then we have learned of other incidents around the country. There are steps people can take to protect their cybersecurity and we encourage all users to follow the proper procedures to ensure their teleconferences are secure."
The statement goes on to offer some advice to help avoid becoming a "zoombombing" victim.
In related Zoom news, CEO and Zoom founder Eric Yuan says that he underestimated the threat of harassment on the Zoom platform, adding that he never gave it any serious thought, according to a report on NPR. Yuan is pleased that the FBI has gotten involved in tracking down "zoombombers," and has cooperated with law enforcement officials every step of the way. His company has halted work on adding new features, instead focusing on privacy and security for the next 90 days. He's willing to make Zoom more secure, with better privacy, even if it makes it more difficult to use.
Some large school districts, companies and governments have banned the use of Zoom entirely, due to the security issues. Google has also banned its employees from installing it on their work computers, saying it doesn't meet security standards.
One recent change to happen to Zoom is that all meetings now require the use of a password. Expect more changes in the future as Yuan works to strengthen Zoom's security. He has recently announced the formation of a security-focused council and advisory board, and hired Alex Stamos, Facebook's former chief security officer, as an outside security advisor to Zoom.
If You Have SuperVPN Free Installed On Your Mobile Device ... UNINSTALL IT IMMEDIATELY!

We've covered the benefits of using a VPN here in The PCLinuxOS Magazine before. You've heard about the benefits of using a VPN, I'm sure, from other sources on the internet. So, if you were duped into installing SuperVPN Free VPN Client on your mobile Android device, uninstall it immediately!
According to an article on Forbes, the app has been installed by 100 million users. It has since been removed from the Google Play store. But, there are many, many users out there who may not realize that the app behaves in a malicious manner.
Specifically, and according the a blog post by VPNPro (who reported the issue to Google):
"... it has critical vulnerabilities that allow for man-in-the-middle (MITM) attacks that can easily allow hackers to intercept communications between the user and the provider, and even redirect users to a hacker's malicious server instead of the real VPN server."
The SuperVPN Free VPN Client was reported to Google Play Security Reward Program, by VPNPro, and Google verified the security issues. Attempts to contact its developer, so he/she/they can patch the vulnerabilities, were unsuccessful. Even trying to track down the actual developer proved to be a monumental and circuitous task that often led to many dead ends.
The "paid" version of SuperVPN VPN Client is still available in the Google Play store. It definitely differs from the free version by not displaying any ads. However, it would probably be a wise idea to avoid the paid version, as well, since it may have similar (if not the same) security vulnerabilities.
Even though the SuperVPN Free VPN Client has been removed from the Google Play store, it's likely that there are many, many users who may still have it installed. Those users may not be aware of the app's security issues, and may continue to use it, mistakenly thinking that they are protected as they would be with a bona fide VPN app.
Do You Think That Fingerprint Reader Is Secure?

Well, do you think that fingerprint reader is secure? According to researchers from Talos Cisco Security Research, it might not be as secure as you think it is.
Yes, it's true that everyone has unique fingerprints. If you have a smartphone, you've probably used your fingerprint to unlock your phone. Some laptops have a fingerprint reader to enhance security of the data stored on the hard drive. Some USB flash drives use fingerprints to secure the data stored upon it.
However, you might be surprised by the answer. And, that answer is mostly NO, that the fingerprint reader can be fooled fairly easily, given enough time and the right materials. Also, all fingerprint readers are not created equal, either. So, the answer becomes "it depends."
Using a 3D printer, they made a mold of Al Capone's publicly available fingerprints from the FBI's website. The mold comes out of the printer, and must be cured in a UV chamber before it can actually be used as a mold. When it comes out of the printer, it is too soft and too toxic to be of any use. The mold makes a "negative" of the fingerprint. It took the authors 50 attempts to come up with a usable mold, due to the 3D printed mold shrinking during the UV curing, depending on the time it spends in the curing chamber. They also used a direct collection method (where a cast of an actual fingerprint is made in softened Plastiline modeling material; this was the most successful method), and an optical scan method that scanned a photo of the fingerprint.
Next, you have to fill the mold with your material to make a "positive" from the "negative" (the mold). The best performing material they found was fabric glue. Fill in the mold with a thin layer of the fabric glue, wait for it to dry, and then carefully peel it up from the mold. Use that "sheet" to press down over the fingerprint reader.

Orange: Direct Collection Blue: Image Sensor Yellow: 3D Printed Molds
Once you've made it this far, this is where the fun starts: seeing if you can fool the fingerprint reader. The researchers first tried a MacBook. Believe it or not, they were able to fool the MacBook fingerprint reader 95% of the time. The iPhone and iPad fared only slightly better than the MacBook at not granting access to an unauthorized user. The Samsung S10 and Samsung Note 9 were easily fooled, as was the Huawei P30 Lite and the Honor 7x. Curiously, the Samsung A70 kept the data secure, but the researchers attribute that to the fact that the fingerprint reader on that device barely works even when it's the "real thing."
The AICase Padlock was pretty much useless when they used the direct collection method, only slightly better when the image sensor method was used, and was only fooled about 30% of the time when using the 3D printed molds.
Amazingly, they were never able to fool the fingerprint reader on laptops running Windows. The researchers attributed this to two traits. First, you tend to "unlock" a laptop less frequently than a mobile device. Because of this, which leads to the second trait, is the fact that Windows samples more data points in the fingerprint. Also, the fingerprint reader code is part of the Windows OS, enabling it to work better across all Windows iterations.
The researchers were also unable to fool the fingerprint reader on the Verbatim Fingerprint Secure USB flash drive, nor the Lexar Jumpdrive F35, regardless of the method they employed.
There was no mention of any tests involving Linux.
So, what were the researchers' conclusions? Well, not much has changed since fingerprint readers were largely introduced in 2013. The security offered by them is pretty much dependent on the method employed to read the fingerprint, as well as how many data points are compared to a saved set of data. The more data points used, the more secure it is, but also the more "finicky" it is, too. Overall, fingerprints are probably sufficient data protection for the more casual user, but can represent a real security hole for individuals and groups that need a higher level of security (2FA would sure seem to be warranted in these cases, I would think).
Windows Explorer File Manager Eases Reading Of Linux File Systems

Image: Microsoft
Do you dual boot your computer with PCLinuxOS and Windows 10? If you do (and I know there are some of you out there), Microsoft has made a once extremely complicated (if not nearly impossible) task of reading data files on your Linux partitions as easy as a couple of clicks in Windows Explorer File Manager.
Now, in Windows 10 Build 19603, as long as you have the Windows Subsystem for Linux (WSL) installed, your Linux files are only a couple of clicks away.
From looking at the images (sorry, but I haven't run Windows since XP ... Vista drove me into the loving arms of Linux), it appears that Windows Explorer will give you access to ALL your Linux files, including those whose permissions are usually reserved for the root user under Linux. So, exercise extreme caution if you use Windows Explorer to manipulate files on your Linux partition. You could render your Linux installation incapable of booting.
Still, it will be quite a timesaver to allow users to access files saved on their Linux partition(s) while working in Windows, instead of making the user log out from Windows, and then boot and sign in to Linux, copying the file to a shared folder or networked drive, and sign back out of Linux, and have to reboot Windows ... all before even doing anything with the data contained in the file. Phew! I get short of breath just typing all of that out!
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GIMP Tutorial: Photo Editing, Part 3
by Meemaw
In an ongoing effort to provide you with several ways to tweak your photos, I have found a few more tips that you can use in GIMP.
Correcting White Balance
Sometimes your camera will react strangely to the light conditions in the scene you want to photograph, and the photo may have a blue (or strange) hue to it, when the colors are obviously supposed to be different. In the photo below, the blue sky almost takes over the whole photo.

Choose Colors > Auto > White Balance, and it should be instantly corrected.

While it looks to me to be closer to the scene I remembered when I took the photo, I'll have to do some more later. Similarly, you may not like the results you get.
If you aren't happy with the automatic results, there's always another way to do things in GIMP. Choose Colors > Levels, and toward the bottom of the window that opens, click on the middle eyedropper icon. This will let you set a gray point in your image, an area of neutral color off which all the other colors will be based.

With the eyedropper selected, find an area of gray in the photo and click on it. The color of the whole photo will update. The good thing about this is that you can keep clicking different grays in different parts of the picture until you find one that you're happy with.
Tweaking Photo Colors in GIMP
Tweaking the colors of your photos can make dramatic effects. Depending on what you do with your photos, you might want vivid colors or subdued colors.
Click on Colors > Hue-Saturation. The Saturation slider will boost your colors. Be careful because it's very easy to oversaturate your images. A good rule is to set the saturation to a level that looks okay, then just drop it back a little. Here, I set the saturation up.

You can adjust the red, magenta, blue, cyan, green, and yellow parts of your image separately by choosing the color and using the Lightness slider.
You can make a sky look bolder and bluer by focusing on the blue and cyan colors, and set the Lightness slider to a darker level. To make grass and foliage look greener and more vivid, increase the Lightness level for green. Here, I've set the lightness for green up a bit. It just increased the green in the foreground.

If you're left with harsh edges around the areas of color that you've adjusted, drag the Overlap slider to the right to help blend them better.
After editing a bit more, I came up with this result.

Removing the Background
Sometimes, you shoot what you think is a perfect shot, but the sky is one big blob of grey-blue. Let's remove the sky and replace it with something better. Fortunately, you can remove the background in GIMP, which enables you to replace the sky with something a lot more interesting. In the photo below, the sky is almost white with no color at all. I want to replace it with something more colorful.

As you can see, the sky has almost no color at all, even after I used some of the above tweaks on it. We'll use one method of editing now. First, choose Layer > Transparency > Add Alpha Channel. Now, choose the Fuzzy Select tool, and click on the sky. You may have to play with the threshold setting to get only the sky, but you can click, then adjust and click again. My threshold was 35, and I got the following:

See the little dots across the tops of the trees? Those dots and the dotted lines over the top are moving, which means that's your selection. Now click on Delete. The sky will disappear.

Now the only thing left is to add a transparent layer and paste a different sky into it. Open your sky and resize it to the width of your photo. Copy and paste it on a newly created transparent layer, then move that layer to the bottom of the layers. Export it to a new file.

Several other ways exist to remove a background from a photo. We'll soon explore others in upcoming articles.
Better than Zoom: Try these free software tools for staying in touch
by Greg Farough
Free Software Foundation, April 3, 2020
Reprinted under Creative Commons
Attribution-No Derivative Works 3.0 license
The COVID-19 pandemic has caused an enormous amount of changes in how people work, play, and communicate. By now, many of us have settled into the routine of using remote communication or video conferencing tools to keep in touch with our friends and family. In the last few weeks we've also seen a number of lists and guides aiming to get people set up with the "right" tools for communicating in hard times, but in almost every case, these articles recommend that people make a difficult compromise: trading their freedom in order to communicate with the people they care about and work with.
In times like these it becomes all the more important to remember that tools like Zoom, Slack, and Facebook Messenger are not benign public services, and while the sentiment they've expressed to the global community in responding to the crisis may be sincere, it hasn't addressed the fundamental ethical issues with any piece of proprietary software.
After taking the LibrePlanet 2020 conference online, we received a number of requests asking us to document our streaming setup. As the pandemic grew worse, this gave way to more curiosity about how the Free Software Foundation (FSF) uses free tools and free communication platforms to conduct our everyday business. And while the stereotype of hackers hunched over a white on black terminal session applies to us in some ways, many of the tools we use are available in any environment, even for people who do not have a lot of technical experience. We've started documenting ethical solutions on the LibrePlanet wiki, in addition to starting a remote communication mailing list to help each other advocate for their use.
In the suggestions that follow, a few of the tools we will recommend depend upon some "self-reliance," that is, steering clear of proprietary network services by hosting free software solutions yourself, or asking a technical friend to do it for you. It's a difficult step, and the benefits may not be immediately obvious, but it's a key part of preserving your autonomy in an age of ubiquitous digital control.
To those who have the technical expertise and available infrastructure, we urge you to consider hosting instances of free communication platforms for your friends, family, and your community at large. For example, with a modest server and some GNU/Linux knowledge, you could help local students learn in freedom by volunteering to administer an instance of one of the programs we'll be recommending below.
The need to self-host can be an uncomfortable reminder of our dependence on the "cloud" -- the network of someone else's computers -- but acknowledging our current reliance on these providers is the first step in making new, dependable systems for ourselves. During dangerous and stressful times, it's tempting to sideline our ethical commitments for easier or more convenient ways to get things done, and software freedom is no exception. We hope these suggestions will inspire you to inform others about the importance of their freedom, privacy, and security.
Chat
When we can no longer communicate face-to-face, tools for voice and video calling often come to mind as the next best thing. But as evidenced by the size and success of the proprietary software companies that sponsor these tools, their development isn't easy. Promoting real-time voice and video chat clients remains a High Priority Project of ours. Though we may still be waiting for a truly perfect solution, there are some projects that are far enough along in their development that we can recommend them to others.

Audio calls

Video calls and presentations

Text chat

Long-form discussion

Document Sharing
If you're unused to working remotely, finding ways to collaborate with others on a document or presentation can be a challenge. At the FSF, Etherpad is the main tool that we use to keep live meeting notes and work together on other documents. It provides all the features you need for quick collaboration, including comments, revision tracking, and exports to a variety of formats. You can host your own instance, or you can select an instance made available by others and start sharing.

File Sharing
At the FSF office, we have a common server to store our files. Not everyone has the luxury of a setup like that, and especially not due to the fast changeover from office to home. To avoid using proprietary "solutions" and disservices like Dropbox, you can turn to the widely popular Nextcloud to synchronize your text and email messages, share calendars with coworkers, and exchange files privately with your friends.
If you need something temporary, there's always Up1. Up1 is a temporary, encrypted text and image sharing program you can host locally, making sure those files you need to exchange are only there for just as long as it takes for your friend to download them. And while we don't use it ourselves, we've heard good things about the Riseup network's instance of Up1, and will occasionally suggest it to those wanting a quick and easy way to share files while retaining their freedom.
Conclusion
This is just a small selection of the huge amount of free software out there, all ready to be used, shared, and improved by the community. For more suggestions on both local and Web-based programs, visit the FSF's Free Software Directory, our volunteer-run wiki which aims to be a comprehensive list of the thousands of free programs available for everyday use.
As always, free software is a moving target. We reap as much as the community puts into it, and as more and more attention shifts to the crisis caused by the novel coronavirus, the tools themselves are likely to see an increased amount of development. Please collaborate with us on the LibrePlanet wiki's entry on remote communication to help people find ways of communicating that put user freedom as a priority.
Supporting the FSF's crucial work in campaigning for software freedom -- especially in times like these -- is one of the greatest things you can to promote the creation of ethical tools for communication. Please consider joining as an associate member or donating today.


PCLinuxOS Family Member Spotlight: jzakiya
What is your name/username?
Jabari Zakiya/jzakiya
How old are you?
64
Are you married, single?
Single
How about Kids, Grandkids (names and ages)?
None
Do you have pets, what is your favorite?
None
Are you retired, still working and if working, what do you do?
Not formally working, but do stuff.
Where do you call home? What is it like? IE: weather, scenery
Washington, DC. Climate change is making it warmer year round.

Our Nation's Capital

ChinaTown (DC Gate)

Row Houses

Where did you go to school and what is your education level?
Cornell, BSEE; Georgia Tech, MSEE
What kind of things you like doing? hobbies, travel, fishing, camping?
Reading (nonfiction, sci-fi), following sports, math/programming, walking, bicycling.
Why and when did you start using Linux?
So long ago, it must be around 0.92 on my AMD Athlon desktop.

PCLinuxOS Swirl

PCLinuxOS .92
What specific equipment do currently use with PCLinuxOS?
2016 System76, Gazelle laptop, i7 cpu, 2.6 - 3.5 GHz, 16GB, 240 GB SSD, KDE5
Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?
None really, except people who I've converted from Windoze to PCLinuxOS.
What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?
To keep current with new hardware/software. The PCLinuxOS Magazine is great. For Tex to keep as healthy as possible (I lost my partner to cancer 2017). For the community to remain/become more cohesive and tolerant (lots of past rancor about systemd, and dropping 32-bits). Appreciate the time we have, and use it wisely and productively.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum members. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.




Champions Of Regnum On PCLinuxOS
by Alessandro Ebersol

Champions of Regnum (Regnum online previously) is a multiplayer 3D medieval fantasy online RPG video game, produced in Argentina by NGD Studios (currently NGE), for free to anyone, with the option to pay for premium content.
It is available in Spanish, Portuguese, German, English and French. The game has 3 servers and an experimental one (for testing), which are "Ra" (international server) "Haven" (international server, mainly in English) "Valhalla" (Germany) and the experimental "Amon". The word "Regnum" comes from Latin and means kingdom.
The game focuses on the conflict between three kingdoms, with gameplay revolving around realm versus realm combat. Players fight in groups against players from opposing factions and capture forts and castles. In addition, the usual character development, typical in other games of the genre, is present, as well as battles between players and monsters.
The Story
Three kingdoms face off to collect 6 gems. Each kingdom has 2 gems, gems that, when fully collected, will open the great portal, allowing access to a new and mystical place. This place has secret rewards that represent the popular will of the kingdom. Once inside this portal, a dragon will appear, which, through a list, will give the wish that most decide. Something like DragonBall.
The 3 Kingdoms of Champions of Regnum

Alsius
In the north of the world, there is a cold and hard to live region, characterized by its snowy and mountainous landscape. This region is especially characterized by the strength, determination and courage of its warriors.
Dwarves came from far and wide in search of new land. The encounter with the Norse was not peaceful, and the two races sparked a bloody war. However, they found that they had similar elements and desires and established a lasting alliance. The arrival of the utghars led to the creation of the Alsius Empire. They decided to build their main fortification in the city of Montsognir, to combat the threat from the elves inhabiting Syrtis and the dark settlers of Ignis. The war between Alsius and the elves stems from a confused episode that ended the life of the leader of that empire. Since then, Garm, the Emperor of Alsius, has summoned his people to guide them to conquer new lands, looking for minerals, valued by the forges for the construction of their weapons.
Races of Alsius:

Syrtis
To the southwest, the oldest civilization persists. Still beautiful, despite having passed its years of splendor, it is green and full of life, full of trees and lakes. The archers of the Republic of Syrtis are famous for being the most deadly of all.
Before the great exile, the inhabitants of the kingdom lived in harmony and peace. The arrival of the igneous and the war that they unleashed was the origin of the division of the elvish houses, because after the victory some took the weapons and spells of their enemies, studying and dominating them. The elves saw a threat to their society in this, so they exiled their countrymen. Fearing possible revenge, the natives allied themselves with the Alturians and the two races intermingled, giving rise to the semi-elves. The union of the two cultures gave rise to the cultural capital of the world, with its greatest exponent in the city of Fisgael. However, the unknown threat is still latent, and the arrival of the invaders from Alsius forced the elves to take up arms, intolerant of any attack on their beautiful lands.
Syrtis Races:

Ignis
Located to the east, there is an arid, mountainous and desert area. Active volcanoes and imposing mountains give a special view to this sea of dunes. Here are the magicians who stand out above all others, due to their knowledge of forbidden magic.
Banished from their lands by an ancient enmity with Syrtis, the dark elves arrived in the desert lands of Ignis. Exiled because of the dark magic practices they found useful, they hold a special grudge against those who rightfully took their homes and against the invaders of Alsius who threatened their rule. Necromancers allied to moloks and skelios to address the threat of both opponents (Syrtis and Alsius), founding the city of resistance, Altaruk.
Ignis Races:

The map of the kingdoms in Champions of Regnum
Classes
In Regnum Online, there are three classes and each has two subclasses or professions, which the player can choose to work in the best way he/she wants. Each of these classes differ widely from the others, providing great variety to the game.
Upon reaching level 10, the player gets a chance to choose one new class, product of the division of the one he/she is in.
Warriors are the front line in Regnum. Their presence keeps groups together and allows coordination, while protecting classes at a distance. They lead the charge and punish those who cannot escape quickly. The main attribute for warriors is strength. Gives them greater physical damage, focus on the spell and more space in the inventory. The constitution is also important, as it increases the health bar and offers resistance against hits / stunning. Upon reaching level 10, the player can choose between the Barbarian or Knight skill tree.
Barbarians are one of the most offensive subclasses of Champions of Regnum, with a focus on hand-to-hand combat. Warriors who choose the barbarian's path gain access to two-handed weaponry and two unique disciplines, Two-Handed weapons' fight and Battlecry. They are the strongest pure damage class in the game, capable of normal brutal attacks, which can make them deadly up close. Along with good damage, barbarians can also be one of the fastest classes in the game.
Knights are one of Champions of Regnum defensive subclasses, focusing on hand-to-hand combat. Warriors who choose to follow the knight subclass gain access to the heaviest armor, in addition to 2 unique disciplines, Vanguard and Shields. Their armor provides the highest basic protection of all classes, which, together with their powers, can make them more difficult to take down. Knights also specialize in using shields and, as a result, they also have a chance to block attacks.
Wizards are a class specializing in ranged combat, dealing damage and supporting allies. They use magic staves as weapons, allowing them to attack from a distance without using ammunition. Unlike the other classes, the wizard gains three additional discipline trees after choosing a subclass, in addition to gaining additional discipline and power points. Upon reaching level 10, the player can choose between the skill tree Warlock or Conjurer.
Warlocks are subclasses of the magician and are one of the most powerful damage dealers in the kingdoms of Regnum. In addition to being a capable area nuker, the wizard is also able to cast effective crowd control spells, cause damage over time, and disturb the enemy using many powerful curses. Together, these skills make the wizard a dangerous and often targeted opponent.
Conjurers are a subclass of the Wizard. Although his standard role is as a healer and support line, taking one lightly is a big mistake. Like all mages, conjurers lack defense, evasion and health, but they have a wide range of crowd-control powers to help overcome these weaknesses. A skilled conjurer can play with his opponent, stunning and knocking him down at will. In addition to crowd control, the conjurer also has access to many damage reduction powers, healing magic and the ability to summon a creature or spirit to assist him/her in battle. Conjurers commanding ghosts, golems, liches and demons are a common sight in the kingdoms of Regnum.
Rangers focus on ranged combat using short and long bows. Rangers are faster than any other class and have a higher evasion rate. The ranger's main attribute is dexterity, giving greater damage to the bow, focusing on the spell and evasion rate. Rangers, without a specific secondary attribute, can choose a balance between concentration, intelligence and constitution. Upon reaching level 10, the player can choose between the Marksman or Hunter skill tree.
The marksman is a class that has good defense and attack, but lacks support. This combination makes them good at PVP, but they are also an essential part of any RVR battle. Their massive range and fast high damage allow them to finish off retreating or wounded enemies. Their debuffs are also quite effective, as they are unique and tend to confuse the enemy. Marksmen have the same great evasion skills as the hunter, but they also have impressive damage-dealing skills. With expanded range and increased accuracy, they can mercilessly attack unwary opponents who think they are at a safe distance.
Hunters are a unique class. Depending on their disciplines, they can be great enemies in fair pvp or silent backstabbers who hit enemies in their moments of weakness. Rangers who choose this subclass give up Marksman's accuracy and increased damage, but gain the use of more interesting spells and abilities. Hunters can tame pets, but without their pets, they are weak compared to the other five subclasses, with no real power improvements. With that in mind, they need to use and sometimes abuse their stealth techniques to kill their enemies.
How to play
When starting the game, each player has the possibility to choose one of the three kingdoms of the game: Alsius, Ignis or Syrtis. As these regions are in constant conflict, the users themselves will form part of the ranks of either kingdom. After the kingdom is chosen, the player will be able to create his character (up to three per account, with the possibility of expanding through Premium content, up to a total of six) and customize it by choosing race, gender, height, color hair etc.
After that, the game itself begins. Throughout it, the player must perform quests and interact with other players to develop and be able to take full advantage of the main feature provided by Champions of Regnum, which is group combat.

Battle in the forest
The character's evolution system is adjusted in such a way that it is necessary to advance to a medium/high level in order to participate in battles (approximately level 45, which is achieved with relative ease). From that level, the required experience curve increases considerably, which requires the player to play a considerable amount of time before reaching its maximum level, level 60. The game has a large number of quests of various types. An NPC can ask to kill several specific monsters, another to kill a character from another kingdom, deliver a package to another NPC or others who tell about the history of the world that surrounds this game.
The main objective of the game is to obtain the six gems, distributed equally among the three kingdoms that make up the game (Syrtis, Alsius and Ignis), conquering the defenses of the enemy kingdoms and, later, entering the enemy territory to steal the gems, in addition to defend your own kingdom and prevent them from stealing the gems mentioned.

Character creation screen
Premium Content
Despite being a completely free game, Regnum Online offers the possibility to obtain new content, paying in real money. However, NGD • Studios "guarantees" that Premium content does not affect the balance between paying and non-paying players. Which is questionable, as the accumulation of legendary, epic, magical and magnanite items (an element for the manufacture of weapons and armor) exponentially increases the amount of damage and defense of the characters who use them. Premium content, which for international server accounts (created on the official page of Champions of Regnum ) is paid via PayPal (international) and PagoFácil (Argentina) and, recently, the SMS payment method was introduced in Argentina, Spain, Brazil, Mexico, Chile and soon to other countries. Consists of buying mounts (horses and creatures for faster movement), character customization items (special haircuts, hair and clothing dyes, exotic hair dyes), experience multipliers, health and mana potions to increase reserves faster, scrolls to transport between points, scrolls to instantly rise to level 45 (of 60), repair hammers to keep the equipment in top condition, possibility to expand the maximum number of characters in the account (3) to 6 permanently, and is constantly expanding.
System requirements:
Game website: http://championsofregnum.com
There, you register, and download the client for the game, which has a 64-bit native Linux version.
Client download: http://championsofregnum.com/index.php?l=1&sec=6
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PCLinuxOS Bonus Recipe Corner: Mashed Potato Mac & Cheese Bake
Mashed Potato Mac & Cheese Bake

Two great comfort foods in one...
INGREDIENTS:
2-3 cups leftover mashed potatoes
2 cups grated cheddar cheese
1 cup grated Parmesan cheese
1 tablespoon unsalted butter
8 oz elbow or shell noodles
1 cup cooked and crumbled bacon
¼ cup chopped chives or green onion, garnish
*Milk or half-and-half, as needed
DIRECTIONS:
Preheat the oven to 350F degrees and bring a pot of salted water to boil. Cook noodles until just al dente, then drain and stir in 1 tablespoon of butter to prevent noodles from sticking together.
Cook bacon, drain on a paper towel and chop into smaller pieces.
Reheat mashed potatoes in a microwave safe dish. Transfer to a large bowl for mixing. Note: If potatoes are dry, add a little milk or half and half for a smoother texture.
Fold in Parmesan cheese, bacon, and 1 cup cheddar cheese and stir to combine.
Gently fold in noodles until just incorporated then pour mixture into a greased 9 x 9 baking dish and top with remaining cheddar cheese.
Bake for 10-15 minutes or until cheesy topping is bubbling and golden brown. Remove from the oven and garnish with chopped chives or green onions sprinkled over the top.
TIP:
Add 1 cup chopped of your favorite seafood or meat.
For that smokey flavor add 1/2-1 teaspoon liquid smoke to mixture
Finally! ShotCut Running On PCLinuxOS!
by Alessandro Ebersol (Agent Smith)
Shotcut is a non-linear video editor, which I always wanted to use. But first, I would like to disclose my background with audio-visual production.
I started making videos for YouTube, with PCLinuxOS, first with Openshot and all the tools that are available in PCLinuxOS repos: Audacity, Openshot, Rezsound, SSR and others.
Openshot was my choice because it has a direct interface and is super simple to operate. In fact, Openshot is simple, but very complete. It has features that are not accessible right from the start, having to be activated, either through different menus or video clip properties. But, it shows the intelligence of the programmer, who decided not to scare his would be users with an intimidating interface.
Then I started using VSDC, from the Windows platform, but thanks to Wine and Play-On_Linux, working perfectly on Linux, to add more effects and other capabilities with characters and fonts that Openshot doesn't have. VSDC also has a very clear and straightforward interface, and its resources are accessible through MS Office ribbon-style menus (now a well spread paradigm among several applications).
What about KDEnlive?
I confess: The KDEnlive interface, which copies Adobe Premiere, scared me away. I was never able to understand that interface, and I think a user should not fight with an application, but work with it. So, I passed on KDEnlive, and, I think Openshot, with its strengths and weaknesses, will be the standard by which I'll judge other video editing programs. Openshot really took a lot of inspiration from Windows Movie Maker. In a way, Openshot is a Windows Movie Maker that rocked the gym, and now has very well defined muscles and a lot of strength in its punches.
Shotcut: An excellent NLVE editor, but it took too long.
In the meantime, I tested other video editors: Flowblade, Pitivi, even Cinelerra. This I do not recommend to anyone who is starting, because the experience is for professionals, not well-intentioned amateurs.
I also tested Shotcut.
I was overwhelmed by the program: elegant, made with the Qt libraries, in C ++, the program was smooth as silk running. It did not crash, was stable and did not consume too many machine resources (Openshot, working, is a resource hog).
But, not everything was rosy: When it came to exporting projects, nothing happened. Shotcut did not work on PCLinuxOS, which prevented me from using it. There was even a post on the forum about this.
But in the latest versions, all problems have been resolved, and, Shotcut now works as it should. And what are my impressions? Next, I'll tell you...
Shotcut: So good that it seems to be a paid program...
Well, the program is so polished that it doesn't look like free software, but a commercial program.
Let's look at the history of Shotcut now.

The main program interface
Shotcut was originally conceived in November 2004 by Charlie Yates, co-founder of MLT and original lead developer. The current version of Shotcut is a complete rewrite of Dan Dennedy, another MLT co-founder and current leader. Dennedy wanted to create an editor based on the MLT and chose to reuse the name Shotcut, as he liked it a lot. He wanted to create something to exercise the new multiplatform features of MLT, especially in conjunction with the WebVfx and Movit plugins.
Features
Shotcut supports video, audio and image formats via FFmpeg. It uses a timeline for non-linear video editing of multiple tracks that can be composed of several file formats. Scrubbing and transport control are assisted by OpenGL GPU-based processing and a number of video and audio filters are available.
Audio
Video effects
Hardware
Another very important feature is the ability to work with color gradations. Yes, Shotcut can be a colorization tool, both for color correction and to give different effects to your clips.

Color correction in Shotcut
The Basics of Shotcut
Well, as I wrote above, my experiences with video editing are based on Openshot. So, I will judge Shotcut by comparing it with Openshot.
The Interface
In terms of the interface, Shotcut presents itself in a more complicated way than Openshot, but it is not something that discourages the user, quite the opposite. It is a matter of adapting to the software and its paradigms: In Openshot, making a fade is super easy. In Shotcut, it is also, but, you should look elsewhere: Anything in Shotcut is a filter. Thus, even a fade is a filter. You must look in the Filters menu and add the Fade filter, both in and out, and then with sliders you can control the intensity and duration. Cross fades are super easy to do, just drag one video clip over the next, and Shotcut does the rest.
Getting Started with Shotcut
To start with Shotcut, let's analyze a screen of a video I was editing (in fact, I edited the video in Shotcut to write this article).

A video being edited in Shotcut
So, let's go to a brief how-to, to encourage you, the future videomaker / filmmaker to take your first steps on Shotcut.
Conclusions
Well, I can only say that I was very positively impressed with Shotcut, and I will make a very direct analysis of its weaknesses and strengths.
Pros
Cons
Verdict
ShotCut is an excellent video editor, which after the user gets used to it, is able to produce very good audiovisual pieces. Of course, it doesn't have all the effects, but it does have a lot of effects. It is based on MLT and FFMpeg, and it can be used in conjunction with Openshot (or another video editor), to achieve the effects it doesn't have. But, the interface is very good, very customizable, and there was no crash during the operation (for me to write this article). It has great stability, and, being written in C, C ++, under the Qt framework, makes it responsive and not too demanding in terms of memory and processor. Of course, the more cores your CPU has, the better.
I highly recommend ShotCut. It's really worth it! And, I hope you enjoy this great program, now working 100% in PCLinuxOS.
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